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1 Introduction

Welcome to Using Vehicle Spy with Ethernet, one of the quick start guides for Intrepid’s
powerful Vehicle Spy (VSpy) network analysis and diagnostics software. In this guide you will
learn about the new VSpy features implemented to support working with Automotive Ethernet,
and go “hands on” to perform basic tasks such as viewing Ethernet traffic, decoding Ethernet
signal data, and creating and transmitting Ethernet messages.

1.1 About the Vehicle Spy Ethernet Quick Start Guide

The purpose of this guide is to help you quickly get up to speed in using Vehicle Spy with
Automotive Ethernet messages and hardware. The guide contains the following six chapters:

1. Introduction: You’re reading it!

2. Configuring Vehicle Spy for Ethernet: Explains how to set up Vehicle Spy to use an
Ethernet interface and work with Intrepid Ethernet hardware and databases.

3. Viewing and Analyzing Ethernet Messages and Data: Shows you how to go online to
view Ethernet traffic on a database, and how best to work with Ethernet messages and
data within Messages View.

4. Simulating and Reviewing Ethernet Message Files: Demonstrates how to simulate
saved Ethernet data for analysis purposes, or simply review the contents of a file.

5. Receiving Ethernet Messages and Decoding Signals: Walks you through creating an
Ethernet receive message in the Messages Editor, including defining a signal, and then
simulating a buffer to view decoded data.

6. Creating and Transmitting Ethernet Messages: Takes you through the process of
defining an example Ethernet message with a signal, setting the signal value, and
transmitting the message both manually and automatically.

Most people learn more readily by doing than reading. Accordingly, this is an interactive guide
that uses examples with step-by-step instructions that you can do on your own computer

as you follow along. Many screenshots are provided to help you understand exactly what is
happening. Action items, meaning steps where you need to actively do something, are set
apart from the rest of the text for greater visibility using a right-facing pointer character (“»”).

1.2 Summary of Ethernet Support Features in Vehicle Spy

Interest in Automotive Ethernet has grown rapidly over the last few years, and Intrepid Control
Systems has positioned itself as a leader in the field. If you are new to the technology, you
may wish to pick up a copy of Intrepid’s book, Automotive Ethernet - The Definitive Guide
(Figure 1). This 1,100+ page reference provides a thorough description of Automotive Ethernet,
as well as a comprehensive description of TCP/IP protocols.

Version 1.0 - February 4, 2016 1 © 2016 Intrepid Control Systems, Inc.
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Figure 1: Automotive Ethernet - The Definitive Guide. Intrepid’s industry-leading book will help you understand Automotive

Ethernet.

Over the last two years, Intrepid has worked hard to implement support for Automotive
Ethernet networks within its flagship Vehicle Spy product. Here are just some of the key
features that have been added:

Logon screen shows Ethernet interfaces and allows one to be selected to work with.
Support for displaying Ethernet messages in Messages View.

Built-in, independent TCP/IP stack with ability to easily set and change IP address and
other parameters.

Support for TCP/IP and AVB message types (UDP, TCP, ARP, PTP, etc.)
Custom column sets and filters for Ethernet, TCP, FSA and PTP.

Messages Editor can generate Ethernet messages with pre-configured headers for IP,
TCP, UDP, ICMP and other protocols.

Automatic default settings loaded for TCP/IP and AVB protocol header fields.

Ethernet packet template editor allows customization of default settings for protocol
headers.

Support for Intrepid hardware tools (see Section 1.3).
Support for the standard Ethernet PCAP driver and loading and saving .PCAP files.
Support for GM-only FSA view and databases, and transmitting/receiving FSA data.

Details View shows Ethernet messages broken down by layer and protocol with
individual signals decoded for TCP/IP, AVB and PTP protocols.

Version 1.0 - February 4, 2016 2 © 2016 Intrepid Control Systems, Inc.
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e Byte highlighting based on selected protocol and field within Details View.

e Support for .VSB (Vehicle Spy binary) files for Ethernet frames, including saving error
frames that are not supported in .PCAP format.

e Support for native MAC address and IP address notation in Messages Editor, Tx Panel
and Application Signals.

1.3 Overview of Intrepid Ethernet Hardware Devices

Intrepid Control Systems offers a growing array of network tools to assist you in the
development of your Automotive Ethernet network:

e RAD-Moon: A simple media converter that allows a BroadR-Reach (100BASE-T1)
device to be connected to a conventional Ethernet network.

e RAD-Star: An active tap that allows messages between two BroadR-Reach devices to
be monitored and sent to a PC, and messages also to be sent to BroadR devices from
the PC.

e RAD-Galaxy: A set of six active taps with a high-speed Gigabit Ethernet connection and
many additional features.

e Ethernet Evaluation Board (EEVB): A special board with two complete BroadR-Reach
nodes and a Lab Manual with more than 20 hands-on experiments to help you quickly
become an Automotive Ethernet expert.

e neoVI FIRE 2: Intrepid’s latest-generation general network interface device includes
Ethernet and Diagnostics over IP (DolP) support.

In addition, Intrepid’s neoVI ION and neoVI PLASMA products support Automotive Ethernet
data logging when used in conjunction with a RAD-Galaxy or RAD-Star.

For more information on Intrepid hardware products, please contact Intrepid Control Systems
or visit our website at http://intrepidcs.com.

1.4 Recommended Prerequisites for Using this Guide

Due to the large number of features in Vehicle Spy, complete coverage of the program is
beyond the scope of this document. We recommend that you be familiar with basic Vehicle Spy
operations before continuing, such as how to start VSpy, navigate menus, go online/offline,
and switch among VSpy window. Experience with Messages View and the Messages Editor

is also recommended. If you are new to Vehicle Spy, you may wish to attend one of Intrepid’s
Vehicle Spy Basics training courses, which are offered both in-person and online.

You can use Vehicle Spy Ethernet features either with the Intrepid Ethernet hardware tools
discussed in Section 1.3, or simply by monitoring a wired or wireless network interface in a

Version 1.0 - February 4, 2016 3 © 2016 Intrepid Control Systems, Inc.
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PC. However, in order to take Vehicle Spy online, you will need an Intrepid hardware device
with a hardware license. This can be any of the Intrepid Ethernet hardware tools discussed
in Section 1.3, except for the RAD-Star or RAD-Moon (which do not use a hardware license).
If you have only a RAD-Star or RAD-Moon, you can use any other Intrepid device, such as a
ValueCAN or neoVI FIRE / FIRE 2, to activate VSpy.

Figure 2 shows an example of what Vehicle Spy may look like when you first launch it with an
Ethernet EVB properly installed. Notice the picture of the device near the bottom of the screen,
and its two nodes listed along with their serial numbers and node letter designations (“A” and
“B”).

File Setup Spy MNetworks Measurement Embedded Tools GMLAMN  Scripting and Automation  Run Tools  Help

[M = offline - - H Platform"(l\lone v]- - - {E} Desktop 1

Logon Name Setup DatalLogger
Veh|cIeScape DAQ
Current 2Eeflinll (None) -8 Setup

Recent | My Setups | Examples

Location

Tutorials B8 Configure Hardware...

§ || Vehicle Network Interface

2 i . i i A 1
? : oy

Tutorial 1 : Basics of Vehicle 5 Ethernet EVE EE0354 (Node A)
? Tutorial 2 : Transmitti Ethernet EVB EE0355 (Node B)
? Tutorial 3 : Decoding Signal Data !
More Tutorials...

3.7.1.65 Professiona
Copyrighted and licensed by Intrepid Control Systems, Inc.
www.intrepidcs.com

Mo Bus Errors

Figure 2: Vehicle Spy Logon Screen with Ethernet EVB Device Installed.
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2 Configuring Vehicle Spy for Ethernet

We'll begin by showing you how to configure Vehicle Spy to work with Ethernet. Most of the
Ethernet features within Vehicle Spy are integrated seamlessly into the program, so no effort
is required on your part to make use of them. All we really need to do is enable PC Ethernet
interface support, and then choose an interface to work with. We’'ll also briefly look at the
Ethernet-related networks that come predefined within VSpy, and how to set up an Ethernet
database platform.

21 Enabling PC Ethernet Interface Support

Since Automotive Ethernet is new, many Vehicle Spy users are not yet working with the
technology. For this reason, the program begins by default with support for monitoring a PC
Ethernet interface disabled. Naturally, we want this turned on, so let’s take care of that first. We
only have to do it once, and then VSpy will remember to keep Ethernet interfaces turned on
whenever we later start the software.

» Open Vehicle Spy 3 Options: Select Options... from the Tools menu.

The Vehicle Spy Options dialog box will open. The setting we are looking for is called Use PC
Ethernet interface, and is located near the bottom left of the window (Figure 3).

5
Wehicle Spy Setup I - : r —— I @
:—[‘:- Spy MNetworks ‘@3 Performance I % Multimedia I @ Text API | fi-¢ License |f7 GPS | (3, Directories I @ Regional Set‘h’ngs|

Simulation Mode

[ simulation Mode Browse...

Hardware Setup

@) One Device Type Enable RTC Sync

V] Autodetect Harduware Part 52 [ sync Multiple Devices to PC

() Multiple Devices

tiple Hardware Set

11850 VPW Mode
@ GM Class 2 three byte header
() Chrysler single byte header

OEM Specific Features
Enable GMLAN

[T] Enable 71839
CoreMini

| [ Enable Hardware Acceleration

Automotive Ethernet Features

[71Enable Auto Update [ Enable Low Latency

Enable Bit Rate Sync

neoVIServer Settings
Enable Server
Enable Device Sharing

[T Enable KwP2000
["Enable GG0s

[1Enable HOLAN

Messages
Show Message Tooltip

Signal Log CSV Export

Problem Log
[] Show Warnings for Missing A2L Items

Replay Options

SW High Voltage ArbId: 55
B WSB/CSV Files Only

VehideScape
[ Enable Traceabiity

Flexray PDU Settings

[ Use PC Ethernet interface ["|Enable DC Plot Compatibility Display PDUs
7 Update PDUs based on Update Eit
| Croe ) Mo aeons

Figure 3: Vehicle Spy Options Dialog.

1. Enable PC Ethernet Interface: Click the square checkbox next to Use PC Ethernet
Interface, and then click [_o< .

A prompt will now appear suggesting that you restart the program.
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2. Restart Vehicle Spy 3: Click and Vehicle Spy will close. (If you are prompted
to save changes, select “No”.) Start the program again from the Windows start menu or
desktop.

When the program loads again you will now see a list of Ethernet interfaces at the bottom right
of the screen, as shown in Figure 4. In this case we have three interfaces shown. Due to the
small window size we use to keep screenshots legible, the names are shortened and hard to
read, but we’ll show you in a moment how to get around that.

Veh'lcleSpy
File Setup Spy Metworks Measurement Embedded Tools GMLAN  Scripting and Automation Run  Tools Help

[ ~ offfine - - - Platform None) ]- - - @ Desktop 1

Logon Name SEtIJp DataLogger
Veh|cIeScape DAQ

Current Platform [({513)] -

Location

Tutorials ; 3 H8 Configure Hardware... Refresh Ethernet Interfaces

- ial ) £ Vehich 8 | Vehicle Metwork Interface Packets/s Total Ethernet Me...
Tutorial 1 : Basics of Vehicle 5, Ethernet EVB EE0354 (Node A) 0 0 Wireless ...

? Tutorial 2 : Transmitting Messages Ethernet EVB EE0355 (Mode B) @ 12 45 Intrepid E...
? Tutorial 3 : Decoding Signal Data © 70 186 Local Are...
More Tutorials...

3.7.1.65 Professiona

Copyrighted and licensed by Intrepid Control Systems, Inc.
www.intrepidcs.com

MNo Bus Errors

Figure 4: Vehicle Spy Logon Screen with PC Ethernet Interfaces Enabled.

2.2 Working with the PC Ethernet Interface List

With PC Ethernet interface support now enabled, we have a list of Ethernet interfaces in

the bottom right of the Vehicle Spy Logon Screen. However, Figure 4 uses a relatively small
window size. You can see more of the interface list by enlarging the window, or by dragging to
the left the vertical slider that divides the hardware device list and Ethernet interface list. You
can also do both, as we did to create Figure 5.
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B8 Configure Hardware... Refresh Ethernet Interfaces

Yehicle Metwork, Interface Packets/s Tatal Ethernet Metwaork Interface
Ethernet EVB EE0334 (Node A) ® 0 0 Wireless Network Connection @ Intel(R) Dual Band Wireless-AC 7260
Ethernet EVB EE0355 (Mode B) @ 12 23387  Infrepid Ethernet EVB ( Local Area Connection 29 : LAN9512/LAN9514 USB...

13 94877  Local Area Connection @ Intel(R)} Ethernet Connection 1217-LM

Figure 5: Resized Hardware Device and Ethernet Interface Lists.

After resizing, we can see that this computer currently has three interfaces: a wireless (“Wi-
Fi”) network adapter, the Ethernet EVB, and the PC’s wired Ethernet adapter. Note that from
Vehicle Spy’s perspective, all of wired Ethernet, Wi-Fi and Bluetooth are considered Ethernet
interfaces and will show up here.

Selecting an Ethernet Interface

The radio buttons are used to select which interface you want Vehicle Spy to use; here the
Ethernet EVB has been selected by default. We are going to start working with Ethernet by
looking at live Internet traffic in Chapter 3, so let’s select the interface that the PC is using
for its Internet connection. On the PC used for this guide, that’s the wired Ethernet interface;
select whichever one is appropriate for your machine.

» Select the Interface Used by the PC to Connect to the Internet: Click the radio
button to the left of the appropriate interface. In our example, it would be the one that
says Local Area Connection (the last one, on the bottom).

Viewing Ethernet Interface Statistics

Notice the two columns on the left side of the Ethernet interface list. The Packets/s column
shows approximately how many messages are being received on the interface each second,
while Total counts all messages seen by Vehicle Spy 3, either since it was started, or since the
list was refreshed.

You can use these columns to monitor overall traffic on the PC’s Ethernet interfaces. This can
be handy in certain cases. For example, if we weren’t sure whether the PC was connected to

the Internet over its wired or wireless interface, the data here would tell us pretty quickly which
one is actually active.

Refreshing Ethernet Interfaces

The [Refresh Ethernet Interfaces| button can be used for two purposes. First, it tells Vehicle Spy to
update the interface list, adding any new network connections that have been added since the
program was started, and removing any that have been disabled. Second, it can be used to
reset the statistics in the two columns.

» Refresh the Ethernet Interfaces List: Click [Refresh Ethernet Interfaces|.

Version 1.0 - February 4, 2016 7 © 2016 Intrepid Control Systems, Inc.
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Your list of interfaces should remain the same, but notice that the packet counts of all
interfaces are reset to zero, and then the active ones begin counting up again.

2.3 Examining PC Ethernet Networks

Vehicle Spy comes pre-configured with a number of different commonly-used automotive
networks. This now includes Automotive Ethernet and related networks. You can view VSpy
networks and manage their parameters in the Networks setup area.

» View Vehicle Spy Networks: Select Networks from the Spy Networks menu.

Since Ethernet is relatively new, most of its relevant information is found near the bottom of the
network list.

» Scroll to the Bottom of the Network List.

You should now see a display similar to that seen in Figure 6.

Eile Setup SpyMNetworks Measurement Embedded Tools GMLAMN  Scripting and Autemation  Bun  Tools Help
[d| ~ | offline P\atform:[(NoneJ 'l (3 Desktop L [3, pata |~
?2 Metworks = EE &
1@5 [ & |ock Settings ] [ Er Properties ] [ $, Statistics ] [Save as Defau\t] [ Restore Program Defaults] [ 28 Hardware Setup... ]
Key Description Hardware Netwark Protocol Setup Baud Rate |Color  |Hardware Rate |Bus State  |Database Metwor | Hidden || :
nets4  ISO9141/KW2K 4 (VNETB)  |Default 1509141/KVW2K 4 (VNET B) Keyword 2000 10417 /A (Default) Auto
nets5  HS CANG (VNET A) Default HS CANS (VNET A) CAN 500000 /A (Default) Auto
netss  HS CANS (VNET A) Default HS CANS (VNET A) CAN 500000 /A (Default) Auto *
nets7  LINS (VNET A) Default LINS {VMET A) LN 10417 /A (Default) Auto
netss HS CAN4 (VNET B) Default HS CAN4 (VNET B) CAN 500000 NfA (Default) Auto
netss HS CANS (VNET B) Default HS CANS (VNET B) CAN 500000 NfA (Default) Auto *
net70 LINS (VNET B) Default LINS (VMET B} LM 10417 NjA (Default) Auto
net7l  |Ethernet DAQ (neoVl 3G) Default Ethernet DAQ (neaVI 3G) Ethernet [v] N/A (Default) Auto
net72  |Ethernet Ethernet PCAP Local Area Connection : Intel(R) Ethernet Connection I21741M  Ethernet N/A (Default) Auto .
net73  MOST (VNET B) Default MOST {VNET E) MOST 1000000 N/A (Default) Auto
net74  FlexrRay1a (VMET B) Default FlexRay 1A (VNET B) FlexRay 5000000 T (Default) Auto
net7s FlexRay 1B (VNET B) Default FlexRay1B (VMET B) FlexRay 5000000 /A (Default) Auto .
netie FlexRay2A (VNET B) Default FlexRay2A (VNET B) FlexRay 5000000 /A (Default) Auto
net77  FlexRay2B (VMET B) Default FlexRay2B (VMET B) FlexRay 5000000 /A (Default) Auto
net78  SW CANZ (neoVI 3G) Default S CANZ (neoVI 3G) CAN 33333 /A (Default) Auto .
net7s SWW CANZ (VNET &) Default SWW CANZ (VNET &) CAN 33333 NfA (Default) Auto
netd0 SW CAN2 (VNET B) Default SW CANZ (VNET E) CAN 33333 NfA (Default) Auto
netdl |FSA {(Mone) {virtual) FSA N/A {Default) Auto .
nets2 |TCP {(Mone) {virtual) TCP N/A (Default) Auto
netd83 HS CANG Default HS CANG CAN 500000 NJA (Default) Auto
net84 HS CANT Default HS CANT CAN 500000 NJA (Default) Auto .
netsds LING Default LING LIN 10417 NJA (Default) Auto
netss LSFT CANZ Default LSFT CANZ CAN 125000 NJA (Default) Auto
nets7 |OP (BR) ETH1 Default OP (BR) ETH1 Ethernet 100 /A (Default) Auto .
netss OP (BR) ETH2 Default OP (BR) ETH2 Ethernet 100 /A (Default) Auto
net8s OP (BR) ETH3 Default OP (BR) ETH3 Ethernet 100 N/A (Default) Auto
netad OP (BR) ETH4 Default OP (BR) ETH4 Ethernet 100 N/A {Default) Auto
netdl OP (BR) ETHS Default OP (BR) ETHS Ethernet 100 N/A {Default) Auto *
nets2 | OP (BR) ETHG Default OP (BR) ETHS Ethernet 100 N/A (Default) Auto L
netd3  |OP (BR) ETH7 Default OP (BR) ETH7 Ethernet 100 N/A (Default) Auto 5
nets4 | OP (BR) ETHE Default OF (BR) ETHE Ethernet 100 N/A (Default) Auto *
netss OP (BR) ETHS Default OF (BR) ETHS Ethernet 100 N/A (Default) Auto
netss OP (BR) ETH10 Default OF (BR) ETH10 Ethernet 100 T (Default) Auto
nets7  |OF (BR) ETH11 Default OF (BR) ETH11 Ethernet 100 /A (Default) Auto
netss OP (BR) ETH12 Default OP (BR) ETH12 Ethernet 100 /A (Default) Auto
netes FlexRay Default FlexRay FlexRay 10000000 N/A (Default) Auto | &
i * (edit) * (edit) » (adit) » (adit) * [adit) * (edit) » (adit) No Bus Errors

Figure 6: Vehicle Spy Network List with Ethernet and Related Networks Highlighted.

The networks relevant to Ethernet are:
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e Ethernet: This is the “main” Ethernet interface. The Network column will show the
interface last used when Vehicle Spy went online.

e Ethernet DAQ (neoVI 3G): Used to received Ethernet traffic from supported Intrepid
hardware devices such as the neoVI PLASMA and neoVI ION.

e FSA: A virtual network to support GM’s FSA technology.

e TCP: A virtual network that displays logical data carried in TCP messages on the
Ethernet network.

e OP (BR) ETHnN: These 12 networks carry individual traffic streams from the tap inputs
on the RAD-Galaxy.

Note that you normally won’t need to change any of the defaults in this area when working with
Ethernet.

24 Setting Up an Ethernet Platform

A platform is a collection of database files that is loaded within Vehicle Spy to provide
information about messages. A platform can be used to create transmit messages that send
data in a particular format, or receive messages that decode data read in from the network.

Platforms are important for many Automotive Ethernet applications, so we’ll now spent a bit of
time learning about them, and how to set them up specifically for Ethernet. In particular, we’'ll
see how to create a platform from an AUTOSAR database file.

Selecting a Platform

The current platform is always displayed in a drop-down box at the top of Vehicle Spy.

To change the current platform, simply select the one you want from the box; VSpy will
automatically load its associated databases. Choosing the default platform, “(None)”, will
unload all databases. The two buttons to the right of the drop-down box are used to set up
databases for a platform, and to save pending platform changes, respectively.

Platform:| (Mone) "|@ @

Figure 7: Platform Drop-Down Box with Platform Database Setup and Platform Save Buttons.

Creating a New Platform
Let's make a new platform that we can use for working with Ethernet.

» Launch Platform Setup: Select Setup Platforms from the Setup menu. A dialog
box appears to allow you to work with platforms. Figure 8 shows how this dialog box
appears before any platforms have been created.

Version 1.0 - February 4, 2016 9 © 2016 Intrepid Control Systems, Inc.



Vehicle Spy Quick Start Guides Using Vehicle Spy with Ethernet

Setup Platforms

Avyvailable Platforms
Ok,

Add

Renarme

Copy

Remove

TR by

Cloze

Figure 8: Platform Setup Dialog Box.

» Add Ethernet Platform: Click the button; another dialog box appears. Enter
the name “Ethernet” and press Enter. Click to exit platform setup.

Vehicle Spy will create your new Ethernet platform, and also set the current platform to
“‘Ethernet”; you should see this in the drop-down box on top of VSpy now.

Adding an ARXML Database File to the Ethernet Platform

We have our platform created but it is currently empty, so we will now want to add a database
to it. Vehicle Spy offers many ways of doing this, but we will focus on doing this via an
AUTOSAR database file, which uses the .ARXML format. For this demonstration, we are
using a custom example file; you should have your own database file you can substitute in the
instructions below.

» Enter Network Database Setup: Select Network Databases from the Setup menu, or
click the 2] button next to the platform selection drop-down box.

The Network Databases view opens, with a list of networks on the left, and tabs along the top
corresponding to different methods of adding databases.

» Go to the ARXML Area: Click the ARXML / UEF / VSDB Support tab.
» Assign an ARXML File to the Platform: Click [ s |

The ARXML Import dialog box appears (Figure 9) to allow you to select ARXML files and
associate clusters with VSpy networks.

Version 1.0 - February 4, 2016 10 © 2016 Intrepid Control Systems, Inc.
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ARXML Import

ARXML Files

ARXML Cluster

Wehicle 5py Network. |

Output file: C:\IntrepidCS\Vehide Spy 3\Ethernet.vsdb

Please select a netwark for each duster by
double-dicking the cells in the network column

Close

Figure 9: ARXML Import Dialog Box.

» Add ARXML File: Click[ ¢ | navigate to the folder containing your .ARXML file,
and select it. The file we are using is called “ethernet_sample.arxml”; yours will probably

have a different name.

Vehicle Spy will show the name of the file in the file list in the top half of the screen, and list the
clusters it references in the cluster/network list in the bottom half.

» Assign Network(s) to ARXML Cluster(s): Double-click in the cell under Vehicle Spy
Network for the clusters that were loaded, and choose which networks you want to

associate with each. In our example we have just one cluster, called “EtherSample”,
which we'll link to the Ethernet network (Figure 10).

ARXML Impart

ARXML Files

ethernet_sample

add ||

Remove I

ARXML Cluster

EtherSample

[T FlesRay1a (vHET B) i

Wehicle Spy Mebwark

|Ethernet -

[CILINS [NET &) o
[T HS CAN4 [WHET B]

[C]HS CANS [VNET B)

[C]LING [WNET B)

|| Ethemet DAG (neovl 35)

Fl Ethemet

[~ |MOST [WMET B)

B8

Qutput file: C:\IntrepidCS\Vehice Spy 3\Ethernet.vsdb

Please select a network for each duster by
double-dicking the cells in the network column

Close

Figure 10: ARXML Import Dialog Box Showing Assignment of Ethernet Network to ARXML Cluster.
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» Finish ARXML Import: After making the appropriate network assignments, press the
button.

Vehicle Spy will now load the database in the .ARXML file and prompt you to save the changes
you have made to your platform (quite visibly, to ensure you don’t lose your work!)

» Save Database Changes: Press either of the flashing buttons to save the changes to
your platform.

Your platform is now set up.

Viewing Platform Database Messages

Platform database messages appear within the database area of the Messages Editor, where
they can be copied to quickly make transmit or receive messages. Let’s take a look.

» Open Messages Editor: Select Messages Editor from the Spy Networks menu.

» Select Ethernet Network: Click the drop-down box next to the words on Network in the
blue header, scroll down until you find the “Ethernet” entry, then select it.

» Select Database Messages: Press the button.

You should now see a set of database messages that you can use with your Ethernet network.
Exactly what appears here will, of course, depend on the contents of the database you loaded.
Figure 11 shows a few example messages from our sample database.

oa hegzages Editor

(e [T T WM | ontetwork [memer RSN || 8]
Key Description EtherType |VLAN Protocol Source Port Destination Port Raw Payload Bytes | Color
i f i o ? i f o i f

[EEEN sample Raw Ethernet Message Raw MNane 00:FC:70:00:00:01 00:FC:70:00:00:02
db44  Sample TCP Message Pva Nane TCP 10.0.0.1 50001  10.0.0.2 60002
db45  Sample UDP Message Py Nane LDP 10.0.0.1 50001 10.0.0.2 60002

Figure 11: Sample Ethernet Database Messages.
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3 Viewing and Analyzing Ethernet Messages and Data

Now that we have Vehicle Spy properly set up, we are ready to begin working with Ethernet
messages and data. In this chapter we'll learn how to go online to view “real world” Ethernet /
TCP/IP messages from the Internet, and see how to work with them effectively within VSpy’s
Messages View. This will include tailoring the display of messages for Ethernet, seeing how to
sort and filter Ethernet messages, using Details View to look at the data within messages, and
learning how to save Ethernet data for later analysis.

This chapter assumes that you have followed the instructions in Chapter 2 to enable PC
Ethernet interfaces, and have chosen the interface that your PC uses to connect to the
Internet.

3.1 Going Online to View Ethernet Messages

Support for displaying Ethernet messages is built into Vehicle Spy, so to start looking at
Ethernet messages, we simply need to go online.

» Go Online: Press the [ button located near the top left of the Logon Screen. You can
also press the  *e button found just below it (these can be seen near the top left of
Figure 4).

Vehicle Spy 3 will automatically switch to Messages View and begin displaying the Ethernet
traffic found on the selected interface. If for some reason the view does not change, simply
select Messages from the Spy Networks menu. Note that if you have previously been
simulating a file in Vehicle Spy, you may need to click the drop-down box next to the [ button
and explicitly choose Run with Transmit.

You should see a display similar to Figure 12. Notice that the [l button has changed to the [
(Stop) button at the top left, and the word Online appears next to it, showing that we are online.
Messages View begins by default in static mode, which groups together similar messages

to make it easier to monitor the network as a whole. In the case of Ethernet, messages are
grouped based on their source and destination addresses, as well as the message type
(EtherType).
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(= New Spy Setup - Vehicle Sp) [ )
File Setup Spy Networks Measurement Embedded Tools GMLAN  Scripting and Automation  Run  Tools  Help
' ~| online. : i Desktop1 -
i _, Platform:| (Mone) | [4, | | [B Desktop . [ Data | |
oo heszages Editor@ @ Messages IE”
[ &scrol | [ Tlpetais | [#Expand @ [&T Time Abs|[ M Pause ] Save | [ X Erase ] Find: | 4

Count Time (absrel) Tx |Er %l Description Arbld/Header Len |DataBytes Metwor

=) oo Messages
133.874ms Ethernet 54.213.179.109 to ... 54.213.179.109...279 EC F4BB 6E 01 3C 00 90 A% CD.. Etherne,

26.013ms Ethernet 54.85.163.145 to 1...54.85.163.145:... 60 EC F4BB 6E 01 3C 00 90 A% CD.. Etherne =
Custom 2 Ethernet 64.4.23.143 to 192...64.4.23.143:40... 480 EC F4BB 6E 01 3C 00 90 A% CD.. Etherne,
Custom 3 Ethernet 65,52, 108,74 to 19...65.52,108.74:443 155 EC F4BB 6E 01 3C 00 90 AS CD.. Etherne
Custom 4 293.936 ms Ethernet 75.111.254.179 to ... 75.111,254.179...92 EC F4BB 6E 01 3C 00 90 A% CD.. Etherne,
Custom 5 305.426 ms Ethernet 34.119.42.175 to 1...84.119.42,175:...92 EC F4BB 6E 01 3C 00 90 A% CD.. Etherne,
115.934ms Ethernet 94.254.121,130 to ...94.254.121.130...60 EC F4BB 6E 01 3C 00 90 A% CD.. Etherne,
16.044m5-'.:3) Ethernet EC:F4:BB:6E:01:3C .. EC:F4:BB:6E:01...60 00 90 A9 CD D2 26 EC F4EBB 6E.. Etherne
TCP 104.16.24.190 to 192.1... 41 17030300 248D A9 54 4E 31...

Custom 1

Custom &
(=) Ed Data Types
Metwaork
B E  pata:0000 : 17 03 03 00 24 8D A9 54 4E 31 7F 1D 03 7R 94 Fa
(@ Transmit
- 0010 : D4 F4 Ze B4 DZ 18 05 35 E6 39 ED BB 59 98 Re FF

@) Errors 0020 : 3% FO 1& 8C &8 33 D5 43 36

Changing
Mo Match

Details for "Ethernet 54.213.179.109 to 192.168.1.146"

Completed Ms:
i s Message on Ethernet from E Name

= [ GMLan Ethernet, Src: WesternD_CD
Internet Protocol Version 4,

Diagnostics
Transmission Control Protocol

Mode Active (NCA)
VNMF
HY Wakeup

= :3:, MNetworks |

neoVl

Ethernet

| Details |

E‘:: | o0 owe o J7OR | W Columns’[default) v|  setup.. | Review Buffer... .

¢ (edit) ¢ (edit) ¢ (edit) ¢ (edit) ¢ (edit) ¢ (edit) | No Bus Errors

TCP

Figure 12: Initial Messages View Display with Ethernet Messages.

You may see some TCP entries in the display; there is one at the bottom of the displayed
message list in the figure. These are logical displays of TCP data carried within Ethernet
messages. To make it easier to see more message types, we can suppress the display of this
inline data in Messages View:

» Disable Display of Inline TCP Data: Near the top of Messages View, find the checkbox
next to the word Expand. Click the box to clear the checkmark from it.

TCP messages will now collapse down so they take up less space. Later on we’ll see how we
can use network filters to isolate or suppress network types.

For now, let’s go offline.

» Go Offline: Press the [ button to go offline.
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3.2 Selecting the Ethernet Column Set

By default, Vehicle Spy begins with the Messages View in its generic display format, which is
designed to support many types of vehicle networks. Since we are specifically interested in
Ethernet, we will change the display to one that provides more information relevant to Ethernet
messages.

» Change the Messages View Columns Display to Ethernet: Near the bottom of the
Messages View you should see the word Columns, and to the right, a drop-down box in
which “(default)” is currently selected. Click the box, scroll down, and change the setting
to “Ethernet” (Figure 13).

Columns l(default) v][ Setup ...
(default) -

s [(adit)

Figure 13: Selecting the Ethernet Column Display. This setting will cause Messages View to display information pertinent to
work with Automotive Ethernet.

The information in the Messages View will immediately change to more Ethernet-specific data
Depending on the size of your display, you may or may not see all of the columns available;
you may also find that some are too narrow to see all of their contents. Enlarge the window
and adjust the columns until you can see all the columns up to Len (short for “Length”). You
should see something similar to Figure 14.

The Count, Time, Tx, Er and Len columns are used in the same way as they are with more
conventional networks such as CAN. Here is a brief explanation of the Ethernet-specific
columns:

e Description: For Ethernet messages these summaries begin with “Ethernet” and then
generally contain the source and destination addresses. These will be either MAC
addresses for plain Ethernet or AVB frames, or IP addresses for TCP/IP messages.

e Source and Destination: The sender and receiver of the message, which again will be
either MAC addresses or |IP addresses.

e Src Port and Dst Port: The source and destination port numbers for UDP and TCP
messages.

e EtherType: The interpreted value of the two-byte EtherType field in the Ethernet header,
indicating the type of data being carried in the frame. Typical values are “IPv4”, “IPv6” or
“‘ARP”.
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¢ Protocol: The interpreted value of the IPv4 Protocol field or IPv6 Next Header field,
specifying the higher-level protocol message being carried in an IPv4/IPv6 message.
This will normally be either “UDP” or “TCP”, or blank for non-IP messages.

New Spy Setup - Vehicle 5 [N E——
File Setup Spy Metworks Measurement Embedded Tools GMLAM  Scripting and Automation  Run  Tools  Help
[ - offline PIatform:[(Nonej v] (B} Desktop % pata |~ |
o8 Messages Editor [ £2 | @ Messages @” o
| ™rter | [owadd || | ©sool | [ Tioetsils ] Clexoand (9] (a7 Time Abg | ) Fause Find: | Arbld/Header -
% X B ‘Coum: |'I'|me (abs,fral}|Tx |Er |Descriuﬁcn |Scurce |Src Port |Desﬁﬂaﬁon DstPort |EtherType | Protocol |VLAN |Len‘
g e [ 1] | | [ 1|
L 1 Ethernet 192.168.1.146 to 192.168.1.1 192.168.1.146 56679 192.168.1.1 53 Pud UDP 33
Custom 1
Lol 1 Ethernet 192,168, 1.1 to 192,168, 1,146 192,168, 1.1 53 192.168.1.146 56673 IPv4 uDP 115
Custam 2 =y 1 Ethernet 192,168, 1,145 to 192.158.1.1 192.168.1.146 61503  192.168.1.1 53 Pvd uDP 83
Custom 3 L 1 Ethernet 192.168.1.1 to 192.168.1.146 192.168.1.1 53 132.168.1.146 61603 IPv4 uDP 115
Custom 4 Lol 14 30240325 Ethernet 192,168, 1.1 to 255,255,255, 255 192,168, 1.1 50846 255.255.255.255 7436 IPv4 uDP 215
Custom § =y 3 310.083 ms Ethernet 192.168.1.127 to 239.255.255.250  192.168.1.127 45533  239.255.255.250 1900  IPv4 uDP 167
Custom & L 12 36ps TCP 65.52.108.74 to 192.168.1.146 65.52.108.74 443 192.168.1.146 50745 Pu4 TCP 129
Lol 16 36 s Ethernet 65,52.108.74 to 192, 168,1,146 55.52,108.74 443 192.168,1.146 50745 IPv4 TCP 183
(= 3 Data Types
=y El 37.563459 5 Ethernet 192.168. 1. 145 to 65.52.108.74 192.168.1.146 50745  65.52.108.74 443 Pvd TCP 54
HNetwork
e L & 15.019010 5 Ethernet 192.168.1.115 to 239.255.255.250  192.168.1.115 65047  239.255.255.250 1900  IPv4 uDP 139
@) Transmit oo 1 TCP 192.168.1.146 to 104.96.210.8 192,168,146 50797  104.96.210.8 0 Fvd TR 1
@ Errors d =y 5 10.009393 s Ethernet 192.168.1.146 to 104.95.210.8 192.168.1.146 50797 104.96.210.8 30 i) TCP 55
Changing < [ 3
Mo Match F
e Detalls for "Ethernet 192.168.1.146 to 192.168.1.1"
Completed Ms
? o Message on Ethernet : 83 bytes captured Name Value 00 90 A2 CD D2 26 EC F4 ..... &~
= @GMLAN Ethernet, Src: EC:F4:B8:8E:01:3C, Dest: WesternD_CD:D2: 26 (00:90:4% BB 6E 01 3C 0OF 00 45 00 .n.<..E
[ i 1 192,168, 1, : 192,168.1,
Diagnostics [# Internet Protocol Version 4, Src; 192,168, 1,146, Dest: 192,168, 1.1 00 45 6C 9E 00 00 £0 11  LEl....
User Datagram Protocol, Src port: 56679, Dst port: 53 L
Node Active (NCA) 4% 26 CO BE 01 32 CO BS  J&..... =
VNME 01 01 DD &7 00 35 00 31 ...g.5.]
F3 A0 AB 50 01 Q0 00 01 ...P...
HV Wakeup =
00 00 00 00 00 Q0 OB 73 ...euast
2 s Networks o 79 6E 64 €3 63 61 T4 63 yndican:
neoVl &F _6E 07 74 77 £9 74 74 on.twitl
<[ m I m k[ m | »
Ethernet
TP | Details |
el o e w3 i@ | .  Columns Ethernet v| sewp.. | ReviewBuffer... =
“ + (edit) ¢ (edit) + (edit) + (edit) + (edit) + [edit) + [edit) No Bus Errors

Figure 14: Messages View After Selecting Ethernet Columns and Adjusting Column Sizes. We can now see several new
columns specific to Ethernet messages: Source, Src Port, Destination, Dst Port, EtherType, Protocol and VLAN.

3.3 Saving an Ethernet Column Setup

Ethernet setups in Vehicle Spy can be saved for later use in exactly the same way you would
do when working with other networks. In this case, since we have now tailored the Messages
View to look good when working with Ethernet messages, we’ll save the setup. Then we can

reload it at any time in the future when we want to work with Ethernet.

» Create a New Setup File: Select Save As from the File menu. When the dialog box
appears, enter “Ethernet Column Setup”.

That’s it. Your setup is now saved, and the next time you load it Messages View will
immediately be ready for working with Ethernet.
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3.4 Viewing Messages in Scroll Mode

We mentioned earlier that Vehicle Spy defaults to aggregating similar messages for easier
tracking and analysis. However, when working with Ethernet it is often useful to see messages
sequentially rather than having them grouped in this manner. Naturally, we can easily change
between the two modes.

» Go Online: Press [4.

» Enable Scroll Mode: Press the button, located near the top left of Messages
View.

You will immediately see the change in the message display, as it (appropriately enough)
begins scrolling, each new message appearing in a separate line rather than being grouped
(Figure 15). Notice also that the Count column has now been replaced by a Line column, the
number of which increases sequentially.

pEpwwEs e

File Setup Spy Metworks Measurement Embedded Tools GMLAN  Scripting and Autemmation  Run Toels  Help

rﬁiv onfine.. ! Platfarm:| (None) | 9| | [B Desktopl % Data |-

%0 Messages Editor [ 53 | @ Massagas@‘ i
| rer | [weada || [CEsael] [C00ehis ] [Mewand (8] Find: | Arbld/Header S

.
% x ‘LIHE |T|me (absjrel)|Tx ‘Er |Descr|puon |Source ‘Src Port |DEshnahnn Dst Port |EtherType |Protocol ‘VLAN |Len ‘
frnd & Filter

|=) oo Messages ‘ | ‘ | ‘ ‘ .

"‘-}'ﬂ 924 13.591ms Ethernet 104.96.203.218 to 192.168.1.146 104.96.203.218 443 192.168.1.146 52798 IPv4 TCP 66
Custom 1
“‘%’“ 925 23.401ms Ethernet 192.168.1.1 to 255.255.255.255 192.168.1.1 50B45  255.255.255.255 7436 IPv4 UDP 215
Custom 2 "‘%’“ 926 490.858 ms Ethernet 192,168.1.146 to 255.255.255.255  192.168.1.146 49699 255.255.255.255 1947 IPv4 UDP 82
Custom 3 "‘-‘{“ 927 83.228ms Ethernet 192,168, 1,146 to 192,168.2.245 192,168.1.146 652543 192.168.2,245 161 IPva4 UDP 120
Custom 4 "‘-}‘“ 928 43ps Ethernet 192,168,1,146 to 192,168.2.245 192,168.1.146 652543 192.168.2,245 161 IPva4 UDP 120
Custom 5 “‘-\f" 929 1099043 5 TCP 192,168.1.146 to 3L.13.71.7 192,168.1.146 52611 31.13.7.7 443 IPv4 TCP 46
Custom & “‘-}'ﬂ 930 Ops Ethernet 192,168.1,146 to 31,13.71..7 192,168.1.146 52611 31.13.71.7 443 IPvd TCP 100
"‘-‘i'ﬂ 931 20.092ms TCP 31.13.71.7 to 192.168.1. 146 31.13.71.7 443 192.168.1.196 52611 Pva TCP 46
= &j Data Types
"‘-}'ﬂ 932 Ops Ethernet 31.13.71.7 to 192.168.1.146 31.13.71.7 443 192.168.1.146 52611 IPv4 TCP 100
Network
e "‘-}'ﬂ 933 199.818 ms Ethernet 192,168.1.146 to 31.13.71.7 192.168.1.146 52611 31.13.71.7 443 IPv4 TCP 54
@) Transmit e 934 211,966 ms TCP 157.55.130. 141 to 192.163.1,146 157.55.130.141 40008  192.168.1.146 51635 IPvé TCP 4
a_) Errors o "‘%’“ 935 Ops Ethernet 157.55.130.141 to 192.168.1.146 157.55.130.141 40008 192.168.1.146 51635 IPv4 TCP 60
Changing =4 3
No Match -
o Details for "Ethernet 192.168.1.1 to 255.255.255.255"
Completed M *
ompEtEa g Message on Ethernet from Ethernet PCAP {icsenet.dl) : 215 bytes captur| Name Value FE FF FF FF FF FF 00 80 ....... i
=] mGMLN‘J Ethernet, Srct WesternD_CD:D2:26 (00:90:A9:C0:D2:26), Dest: Broadca 49 CD D2 26 0F 00 45 00 ...&..E|_
Diagnostics Internet Protocol Version 4, Src: 192,168, 1.1, Dest: 255.255.255.255 00 C9 DO 00 40 00 40 11 e.@ 3
User Datagram Protocol, Src port: 50846, Dst port: 7436 TR
Node Active (NCA) 78 7B CO A8 01 01 FF FF x{.....
VNME FF FF C6 SE 1D 0OC 00 BS ....uas
2B 57 4B 41 4E 4E 4F 55 +WERNNCI
HY Wakeup
25 4E 00 00 00 OO OO 00 %N.....
= s Networks O 30 A3 CD D2 26 57 44 43 ....&WD(
necyl S5F 44 42 37 35 30 00 00 DBT50. ~
1| n N m o] [ | »
Ethernet
Tep ‘ Details |
= | o0 A5 0 3 iR ‘ Columns | Ethernet - |[ Setup ... Reviews Buffer...
i3 + (adit) + (adit) ¢ (edit) + (adit) o (edit) + (adit) + (edit) No Bus Errors

Figure 15: Messages View After Enabling Scroll Mode.

Ethernet traffic can come into Vehicle Spy quickly, so you may find it helpful to make use of the
button to temporarily halt the message scrolling when in this mode.

Now let’s go back to static mode and go offline again.

» Enable Static Mode: Press again to turn off scroll mode.
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Vehicle Spy 3 resumes showing you messages statically aggregated by type with counts.

» Go Offline.

3.5 Sorting Messages by Column Value

Ethernet messages in Messages View can be sorted by clicking on column headers in exactly
the same way as you might do with other networks. Let’s try an example.

» Sort by Source Column: Click on the Source column.

All of the messages in the buffer will now be sorted based on their source IP address or MAC
address; you should see something similar to Figure 16. As always, you can choose from
ascending order (24 symbol shows in the column) or descending order (%4 symbol). Of course,
you can also sort using the standard columns, such as Count or Len.

Line Time (abs/rel)| Tx |Er |Description %l Source Src Port | Destination DstFort |EtherType|Protocol |VLAN |Len
""‘?‘“ 3193 52,456 ms TCP 23.92.109.10 to 192.168.1.146 23.92.109.10 3 192,168.1.146 60500  IPv4 TCP 69
“‘-;“ 603 Ops Ethernet 23.92,109.10 to 192.168.1.146 23.92,109.10 443 192,.168.1.146 60500 IPv4 TCP 123
"';“ 602 43.633 ms TCP 23.92.109.10 to 192.168.1.146 23.92.109.10 443 192.168.1.146 60500 IPv4 TCP 69
""‘?‘“ 599 Ops Ethernet 23.92,109.10 to 192,168.1.146 23,92.109.10 3 192.168.1.146 60500  IPv4 TCP 123
“‘-;“ 598 45.316 ms TCP 23.92.109.10 to 192.168.1.146 23.92,109.10 443 192,.168.1.146 60500 IPv4 TCP 69
"';“ 3849 301ps TCP 23.92.109.10 to 192.168.1.146 23.92.109.10 443 192.168.1.146 60500 IPv4 TCP 69
""‘?‘“ a5z Ops Ethernet 23.92,109.10 to 192,168.1.146 23,92.109.10 3 192.168.1.146 60500  IPv4 TCP 123
“‘-;“ 3851 50.810 ms TCP 23.92.109.10 to 192.168.1.146 23.92,109.10 443 192,.168.1.146 60500 IPv4 TCP 69
“';“ 2315 Ops Ethernet 23.92.109.10 to 192.168.1.146 23.92.109.10 443 192.168.1.146 60500 IPv4 TCP 123
":;“ 2314 47.557 ms TCP 23.92.109.10 to 192.1568.1.146 23.92.109.10 443 192.168.1.146 60500 IPv4 TCP 69
“:;“ 3850 Ops Ethernet 23.92,109.10 to 192.168.1.146 23.92,109.10 443 192,168.1.146 60500 IPv4 TCP 123
“';“ 2311 Ops Ethernet 23.92.109.10 to 192.168.1.146 23.92.109.10 443 192.168.1.146 60500 IPv4 TCP 123

Figure 16: Messages View with Ethernet Data Sorted by Source Address. This is the top of the buffer, showing messages
with the lowest-numbered Source addresses captured in this session: 23.92.109.10.

Let’s now remove the sorting:

» Remove Sort: Click the Source column two more times to return to the default view.

3.6 Column Filtering with Ethernet Data

Filtering using columns is a quick and easy way of isolating groups of messages from what can
be a very large buffer of Ethernet data. Simply enter the filter criteria into the Filter bar as you
would when working with CAN or another network. As always, you can use question marks
and asterisks as wildcards, hyphens for ranges, and commas to create lists of values.

As an example, suppose we want to find all of the Domain Name System (DNS) messages
sent by our PC. These requests are used to resolve names like “www.intrepidcs.com” into IP
addresses. DNS requests are sent to the connected Internet provider’s server on destination
port 53.
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» Filter for Outgoing DNS Messages: Enter “53” into the Filter bar cell under the Dst
Port column.

The message display will now change to show only the messages we are interested in; an
example can be seen in Figure 17.

Count | Time (absfrel)| Tx |Er %L Description Source Src Port | Destination Dst Port |EtherType |Protocol [VLAM [Len
Filter 53

“"\r"u 1 Ethernet 192.168.1.146 to 192.168.1.1 192.168.1.1496 57424 192.168.1.1 53 IPv4 LDF 133
"}?‘“ 1 Ethernet 192.168.1.146 to 192.168.1.1 192.168.1.146 51558 192.168.1.1 53 IPv4 Lop 32
"}?‘“ 1 Ethernet 192, 168. 1,146 to 192,168.1.1 192,168.1.146 56737 192,168.1.1 53 IPv4 Lpp 133
""\‘?“ 1 Ethernet 192, 1658.1. 146 to 192.1658.1.1 192.168.1.145 58953 192.168.1.1 53 IPva Lop 78
"}?‘“ 1 Ethernet 192, 168.1.146 to 192,168.1.1 192,168.1.146 50774 192,168.1.1 53 IPv4 Lpp 78
“"\r"u 1 Ethernet 192, 168.1. 146 to 192.168.1.1 192,168.1.146 51041 192,168, 1.1 53 IPv4 LDP 33
"}?‘“ 1 Ethernet 192.168.1.146 to 192.168.1.1 192.168.1.146 54543 192.168.1.1 53 IPv4 Lop 133

Figure 17: Messages View with Active Column Filter.

Let’'s now remove the filter.
» Clear DNS Filter: Remove the “53” from the Dst Port filter cell.

Messages View will return to showing all messages.

3.7 Ethernet Network Filtering

Sometimes you may be working with a mixed network containing Ethernet, CAN, LIN and
possibly other types of messages. In addition, as we’ve already seen, some Ethernet
messages actually generate two lines in Messages View: one for the basic Ethernet message,
and one for the virtual TCP network. If FSA is in use, these messages too will show up with
both Ethernet and FSA entries.

To view traffic from specific networks, use the network filter columns on the left side of
Messages View. The left-most column with the checkmark at the top is used to include
networks you want to see, and the center column with the “X” excludes networks you do not
want. (The right-most column is for custom filters, which we won’t be covering in this guide.)

For example, suppose we want to see only the logical TCP messages on the network, and not
the underlying Ethernet messages that carry them.

» Include the TCP Network: Click the box in the left-hand column for the TCP network. A
checkmark appears.

» Exclude the Ethernet Network: Click the box in the center column for the Ethernet
network. An “X” appears.

Figure 18 shows what the filter area should look like. After entering these filters, you should
see only TCP messages in the message display area of Messages View. (You may need to
click the mouse in the messages area for it to update.)
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Ethernet ﬁ
TCP d

Figure 18: Filters to Show TCP Messages and Exclude Ethernet Messages.

Note that, as always is the case in Vehicle Spy, if you want to exclude a network, you must
include at least one network explicitly or nothing will be shown.

» Remove the TCP Network Inclusion: Click the checkmark next to the TCP network to
remove it.

Since no network is now included, you should now see the messages area go completely
blank (again, you may need to click in the messages area to see this).

» Remove the Ethernet Network Exclusion: Click the “X” next to the Ethernet network.

Messages from all networks are now displayed again.

3.8 Using Details View to Examine Message Headers and Data

The blue rectangular area at the bottom of Messages View is sometimes called Details

View or the Details Pane, and allows you to dig into the fields in any message to let you see
what’s really going on in your network. It's an especially powerful tool for Automotive Ethernet
because you can use it to examine each of the layers of headers and data found in complex
encapsulated messages such as those used in TCP/IP.

You should see Details View open, unless it was previously disabled in a prior use of VSpy on
your machine. If you don’t see it, press the | >l betails | button to enable it.

The Details View window contains three panes. The information pane on the left shows a list
of messages and decoded information about them; for Ethernet messages, you will see here
a list of the headers in the message. On the right is a byte/character display of the selected
message. In the center, you’ll see an area with Name and Value columns that are used to
display the values of decoded messages. The contents of all of these panes will change
depending on the type of message is selected in the Messages View. The relative sizes of the
three panes can be changed by dragging the vertical dividers between them.

As an example, let’s try looking at a TCP/IP UDP message. We can find one easily by using a
filter.

» Filter for UDP Messages: Enter “UDP” in the Protocol filter cell.
Now just click any of these messages.
» Select a UDP Message: Click any UDP message currently shown in Messages View.

You should now see details for the message shown in Details View, like the example in
Figure 19.
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Details for "Ethernet 192.168.1.1 to 192.168.1.146"

Message on Ethernet : 115 bytes captured Mame Value EC F4 BE 6E 01 3C 00 %0 ...m.<.. o
Ethernet, Src: WesternD_CD:D2: 26 (00:90:A%:CD:D2:25), Dest: EC:F4:BB:6E:01:3C A9 CD D2 26 08 00 45 00 ...&..E. I
Intermet Protocol Version 4, Src: 192,168, 1.1, Dest: 192,168, 1,146
User Datagram Protocol, Src port: 53, Dst port: 61041

BHEEBB

00 &5 00 00 40 00 40 11 .e..@.@.
B6 A4 CO AB 01 01 CO A8 ........

m
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Figure 19: Details View for a UDP Message.

As you can see, there are four lines in the left-hand pane. The first is the general information
line for an Ethernet message. The next three show the nested headers for a UDP message:
Ethernet, Internet Protocol and User Datagram Protocol.

If you select one of these lines, the corresponding header bytes in the message will be
highlighted in the data area on the right.

» Select the Internet Protocol Header: Click the Internet Protocol Version 4 header in
the information pane.

You should see 20 bytes highlighted in gray in the byte area, corresponding to the 20 bytes in
a standard IPv4 header (Figure 20).

Details for "Ethernet 192.168.1.1 to 192.168.1.146"
Message on Ethernet ; 115 bytes captured Name Value EC F4 BE 6E 01 3C 00 90 ...n.<.. -

Ethernet, Src: WesternD_CD:D2:26 (00:90:A9:CD:D2:26), Dest: EC:F4:BB:6E:01:3C L9 CD D2 26 08 00 [N
E Internet Protocol Version 4, Src: 192,168, 1.1, Dest: 192.168.1.146

DOMGSEOOM0 04000401 1|
1 B ey PR okl hd (ede] S
UEl £ 00 35 EE 71 00 51
40 2C FE OF 81 80 00 01
00 02 00 00 00 00 OR 67 ....... o
6F 6F &7 6C 65 6D 61 63 ooglemai
6eC 01 &C 06 &7 6F 6F &7 1.1.goog

| 1 | ]« T | F -
AT FE N7 £ FRW R AN AN 1a m~rm

User Datagram Protocol, Src port: 53, Dst port: 61041

Figure 20: Details View Display for a UDP Message with IP Header Highlighted. Here we have the Details View display for
a typical UDP message. When the IPv4 header is selected in the information pane, Vehicle Spy 3 highlights its 20 bytes in the
byte/character display area.

Notice that each header has a “+” button to its left. We can use these to “drill down” into the
headers to look at the fields they contain.

» Expand the UDP Header: Click the UDP header in the Details View information pane,
and then click the |+l button to the left of it.

Vehicle Spy now highlights the UDP data bytes in gray (right-hand pane), and shows you the
values of the fields within the UDP header in this message (left-hand pane). An example is
shown in Figure 21.
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Details for "Ethernet 192.168.1.1 to 192.168.1.146" ﬂ
Meszage on Ethernet @ 115 bytes captured Name Value EC F4 BB 6E 01 3C 00 50 ...m.<.. Il
Ethernet, Src: WesternD_CD:D2: 26 (00:90:A%:CD:D2:26), Dest: EC:F4.BB:6E:01:3C LS CD D2 26 Of 00 45 00 ...&5..E.

Internet Protocol Version 4, Src: 192,168.1.1, Dest: 192,1658.1.146 00 65 00 00 40 00 40 11 .e..G.E.

Source port: 53 B6 B4 CO A8 01 01 CO BE  ........
Destination port: 61041 01 92 33 E 51 F
Length: 81 m E FE OF 81 80 00 01 [EM......
Checksum: 0x402C 00 02 00 00 00 00 OB 67 wuiveves g
6F 6F 67 6C 65 6D 61 6% ooglemai
6C 01 6C 06 €7 6F &F 67 1.l.goog
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B User Datagram Protocol, Src port: 53, Dst port: 61041

m

Figure 21: UDP Message Details View with Expanded Ethernet Header. The same UDP message shown in Figure 20,
but with the UDP header selected and expanded to show its fields. Notice the change to the highlighting in the byte/character
display area.

You can also highlight specific fields in the headers to find exactly where they are located in
the bytestream of the message.
» Highlight the Source Port Field: Click the Source Port field under the UDP header.

You will now see just two bytes highlighted in gray on the right, since this field is 16 bits long
(Figure 22).

Details for "Fthernet 192.168.1.1 to 192.168.1.146"
Message on Ethernet : 115 bytes captured Name Value EC F4 BB 6E 01 3C 00 20 ...n.<.. |«
Ethernet, Src; WesternD_CD:D2: 26 (00:90:A9:C0:02:26), Dest: EC:F4:BB:8E:01:3C LS CD D2 26 OF 00 45 00 ...&..F.

Internet Protocol Version 4, Sre: 192,168, 1.1, Dest: 192.168.1.146 00 65 00 00 40 00 40 11 c..@.8

[=l User Datagram Protocol, Src port: 53, Dst port: 61041 T =

B6 A4 CO A8 01 01 CO A8 .cu.ivunss

i~ Source port: 53

Destination port: 61041 01 82 k& EE 71 00 51 ...q.Q
Length: 81 40 2C FE OF 81 80 00 01 B, ......
Checksum: 0x402C 00 02 00 00 00 00 OR 67 wevuu.. z

6F 6F 67 &6C 65 6D 61 63 ooglemai

6C 01 &C 06 &7 6F 6F 67 1.l.goog

< LLI] | | Jil, | "ller g2 n2 £2 &7 en oAn oAA Ta mew i

Figure 22: UDP Message Details View with Source Port Field Selected. Note that the value of the field is 53 (decimal)
corresponding to the byte value 35 (hexadecimal) in the byte/character display.

3.9 Saving the Message Buffer

After you capture some important data from your network, you can easily save it to a file for
later analysis.

» Click the Save Button: Click the button near the top of Messages View.

You will be prompted with an options dialog box like the one in Figure 23.
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Save Monitor Data —— . .

FileName Save

Your data is
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saved to your
data directory.
Access it
through the

toolbar. bislp
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] E
= 4

[ Save as a compressed ZIF file

Ex

Save signals I
[¥] Append date and time to custom file name
File Format

[Vehl:\e Spy Binary (*.VSB) -

Figure 23: Save Buffer Data Dialog Box.

In most cases the defaults here are what you want: the .VSB format is ideal for Ethernet
messages. Having Append date and time to custom file name checked will make it easy to find
saved buffers, and ensure that later buffer saves don’t overwrite newer ones.

Note that Ethernet data can also be stored in .PCAP files (which are compatible with other
TCP/IP network analysis tools) but not in VSpy’s traditional .CSV format.

» Save the Buffer: Click the button.
The buffer will be stored in your current data directory.

» Open the Data Directory: Click the | ®0ata |-/ putton located near the top right of Vehicle
Spy.

VSpy will launch Windows Explorer set to the location of your data directory. Sort the list by
Date Modified and you should see your buffer at the top.

One important note: be sure to clear network filters that exclude underlying Ethernet
messages—Iike the one we used in Section 3.7—before saving the buffer. If you include a
virtual network like TCP or FSA, but exclude Ethernet, then no messages will be saved.
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4 Simulating and Reviewing Ethernet Message Files

Once you have saved Ethernet data to a file, you have several options for working with it. Two
of the most important are simulating the file and reviewing it, which we’ll show you how to do in
this chapter.

Note that this part of the guide assumes that you saved a buffer of Ethernet data in
Section 3.9. If you have not done this yet, please review the relevant parts of Chapter 3 and
save an Ethernet buffer before proceeding here.

4.1 Simulating an Ethernet Data File

Simulating a data file is an alternative to going online with a live network. Vehicle Spy will
replay the file, causing its messages to appear in Messages View in the same order, and with
the same timing, as occurred on the network when they were captured. This is a useful tool
for diagnosing problems, since you can repeat a message exchange in the same way multiple
times. You can also control the speed of the simulation, slowing it down for easier observation.

If you’ve simulated a file in Vehicle Spy before, the process is pretty much the same for
Ethernet data files.

» Browse to Data Directory: Click the down-arrow next to the [ button, hover the
mouse over Run Simulation, and when the submenu appears, select Browse...
(Figure 24).

mlj Offline ] Platform:’(Nonej v] @' Desktop 1
m Run with Transmit @I

Run Monitar Onl
g o Y ld [ 2 Seroll ][ ~ Details ] [7] Expand E] aT Time Abs Paus
°F - [= [EPTRP E P — [
@ Run Simulation » | [ CIntrepidCS\Wehicle Spy 3\Data Directory\Default\Bus Traffic 2-03-2016 11-07-18 am.vsh
[B Run Analysis 4 Mo Replay File
[B] Runwith remote neoVl ||j" Browse...

Figure 24: Browsing to a Simulation File.

A Windows file selection box will now appear opened on your data directory.

» Select a Simulation File: Click the file you want to simulate (probably the one you
saved earlier in the guide), then click the button.

Assuming that a valid file was selected, Vehicle Spy will begin playing back its messages
within Messages View. The screen will appear quite similar to how it did when going online
live, except that you will notice the simulation bar at the top, which shows you VSpy’s progress
as it goes through the file (Figure 25). The current speed of the simulation is shown in the bar
(in the figure it says “speed: 1.00x”). You can change this by moving the adjacent speed slider
left or right, selecting a speed from 0.01x to 20x.
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Figure 25: Simulating an Ethernet Data File.

By default, the simulation will continuously loop through the file. You can turn this off by clicking
the [Z] button.

You stop the simulation by going offline.

» Go Offline: Press the [ button.

4.2 Reviewing an Ethernet Data File

Reviewing a file is used most often to simply look at what messages it contains. You choose
the file and the messages are shown in the order they were stored with the same timestamps.
Again, this process is pretty much the same for Ethernet data as it is for other networks.

Let’s try an example.
» Tell Vehicle Spy to Review a File: Choose Review Buffer... from the File menu.

» Select a File: When the Windows file selection dialog appears, select a file from your
data directory.

Vehicle Spy will now present a dialog box allowing you to choose what platform you want
to use and whether you want to load the file in standard or streaming mode. Again, this is

Version 1.0 - February 4, 2016 25 © 2016 Intrepid Control Systems, Inc.



Vehicle Spy Quick Start Guides Using Vehicle Spy with Ethernet

identical to what happens when reviewing a .VSB file with CAN or other network data. In most
cases we can leave these options at their default settings.

» Proceed with File Review: Click the button.

Vehicle Spy will load the buffer file, stopping with the last message showed at the bottom of the
Messages View display.
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5 Creating Ethernet Receive Messages and Decoding Signals

In the preceding chapters we have learned how to view and work with live Ethernet messages
on an Internet connection. You can work with your automotive network in exactly the same
way, going online and monitoring network traffic. When working with actual ECUs and other
Ethernet nodes, however, you will often want to create Vehicle Spy receive messages that
describe particular message types and provide information for VSpy to decode their contents.

This can be accomplished with Ethernet messages in a manner similar to how you have
traditionally worked with CAN and other network data. However, due to the complexity of many
Automotive Ethernet message formats, Intrepid has added special capabilities to make working
with Ethernet messages more user-friendly.

In this chapter we’ll see how to define an Ethernet receive message, add a signal to it, and
then decode Ethernet data using the message definition. We have created a special data
buffer of Ethernet messages and put it on our website to assist with this demonstration. Before
proceeding, please download the file from the following location, and store it in your data
directory or anywhere else on your PC: http://www.intrepidcs.com/ae/ethernet_data.vsb

5.1 Creating an Ethernet Receive Message

We'll begin by defining a basic Ethernet receive message. Again, the process is very similar
to doing this for a CAN message, so assuming you have some VSpy experience, much of the
following should be familiar.

Let’s clear out anything that may already be present within Vehicle Spy, and then go to the
Messages Editor.

» Reset Vehicle Spy to Start Configuration: Select New from the File menu.
» Open Messages Editor: Select Messages Editor from the Spy Networks menu.

Since we want to work with Ethernet, we will change the default in the on Network drop-down
box from the default of “HS CAN” to “Ethernet”.

» Select Ethernet Network: Click the drop-down box in the blue header and scroll down
until you find the “Ethernet” entry, then select it.

We should already be on the “receive side” of the Messages Editor, as indicated by the blue
highlighting on the button. If for some reason it is not blue, press this button to
select receive messages.

Finally, create the message.

» Create Receive Message: Click the 9 button to the right of the on Network drop-down
box.

Vehicle Spy will create a default Ethernet receive message, like the one in Figure 26.
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Figure 26: Default Ethernet Receive Message.

As with any VSpy message, we can rename the message or change other parameters. Let’'s change
the default name to something more descriptive.

» Rename Receive Message: Double-click the current message name (“Message Ethernet 17)
and change it to “Decoded Ethernet Message”.

5.2 Working with EtherTypes and Ethernet Headers

Creating an Ethernet receive message is similar to creating one for CAN, but as you can see
in Figure 26, the message itself is quite different. Here are a few things to note about this
message:

¢ In the message list at the top, there are Ethernet-specific columns such as EtherType,
Protocol, Source, (Source) Port, Destination and (Destination) Port.

e The setup area currently has two tabs: Ethernet Header and Ethernet Payload.

By default, Vehicle Spy creates a so-called “raw” Ethernet message, which includes only the
basic 14-byte Ethernet header and room for arbitrary signals (fields) in the payload section.
Let’s take a look at the Ethernet header.
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» Select Ethernet Header: Click the Ethernet Header tab in the setup area for our
message.

A set of three signals is displayed. If you widen the window you can see the byte positions they
occupy, as shown in Figure 27. As you can see, the standard header contains three signals
(fields): Destination MAC Address, Source MAC Address and EtherType or Length. The total
length of the header is 14 bytes.

Byte 7 Byte 3 Byte 9 Byte 10 Byte 11 Byte 12 Byte 13 Byte 14 Byte 15
EEEEREE RS EEEREEEEE R E S EEEREEE R EE R EE R E R R EE R EEEEE A AR 7 s s <
iress 5 4| c
e Anclog EEEEEEBEEEEEEENBEEEEERE B EEE BB AR EBEEEEEEEER
en StateEncoded CEEEERBEEEEEEERE

Figure 27: Receive Message Ethernet Headers.

This is one of the Ethernet -time-savers built into Vehicle Spy. These fields are always
required, so VSpy creates them for you. Note that they can be viewed, but not edited.

Vehicle Spy also sets default values for the standard header fields, which you can see in

the message list: the default Source MAC Address is “00:FC:70:00:00:01”, and the default
Destination MAC Address is “00:FC:70:00:00:02”. These values can be changed, either here
or in the Tx Panel.

The EtherType entry in the message list controls the type of Ethernet message that is defined;
you can see that it is currently set to “Raw”. For this example, we actually want to create an
IPv4/UDP message, so let’s change the EtherType.

» Change EtherType to IPv4: Double-click on the word “Raw” in the EtherType column,
and a drop-down box appears. Select “IPv4”.

The Source and Destination fields change their values to “10.0.0.1” and “10.0.02” respectively.
These are default IPv4 address values pre-assigned by Vehicle Spy.

Look in the message details area and you will now see that the tabs have changed: Ethernet
Payload has been replaced by two new tabs: IPv4 Header and IPv4 Data.

» Select the IPv4 Header: Click the IPv4 Header tab.

You will now see about a dozen new fields have been defined to meet IPv4 protocol
requirements. These ensure that your TCP/IP messages are valid, and are preloaded with
default values that normally do not need to be changed.

Finally, let’s set this to be a UDP message carried within an IPv4 message:

» Change Protocol to UDP: Double-click the word “Raw” under the Protocol column and
select “UDP”.

Again the message is updated automatically with new headers and defaults. Since UDP uses
port numbers, default values (60001 and 60002) have been provided. New UDP Header and
UDP Data tabs have replaced the /Pv4 Data tab.

» Select the UDP Header: Click the UDP Header tab.
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You should now see four signals as shown in Figure 28. Notice how these correspond to the
fields we saw when looking at real UDP messages from the Internet (refer to Figure 22).

Byte 35 Byte

Signals in Message 36 Byte 37 Byte 38 Byte 39 Byte 40 Byte 41
Description 5 5 5 5 5 5 . 5 . 6 6 L 6 6 S
Source Port =|elo|c|a|a|=] 2] 7] &| =[] 2] 2] ] o

Destination Port Anzlog CEBCEEBEEEEREEEE
UDP Header + Data Length Analog EEBEEREEEEEREERE
UDP Checksum Analog EEBEEEEEEEEREERE

Figure 28: Receive Message UDP Headers.

Byte 42

CEEEEERE

5.3 Defining a Signal in a Receive Message

The process to define custom signals in Ethernet receive messages is the same as that used
for traditional networks. The file we will be using in the next section was created as a TCP/IP
UDP message with a single 8-bit field used as a sequential counter. Let’s add this signal now
to the UDP data area so that we can decode it when we simulate the file.

» Select UDP Data Section: Click the UDP Data tab in the signals area.
» Add Signal: Click the * button to create a signal.
A signal with the default name “Signal 22” is created. Let’s rename this.
» Rename Signal: Double-click the signal name “Signal 22” and change it to “Counter”.

Your Vehicle Spy window should now look like Figure 29. Our receive message is ready to use.
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Figure 29: UDP Receive Message with Counter Signal.
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54 Simulating an Ethernet Data Buffer to View Decoded Signals

Now that we have a receive message defined, let’s simulate the Ethernet data buffer we
downloaded earlier, and see how the receive message decodes it.

» Run Simulation on Downloaded Ethernet Data File: Click the down arrow next to
the online/offline button, hover the mouse over Run Simulation, select Browse... and
navigate to the location where you saved the file you downloaded from the Intrepid
website. Then select that file.

» Switch to Messages View: Select Messages View from the Spy Networks menu.

» Select Ethernet Column Set: Change the column set to Ethernet as you did earlier in
the guide.

You should now see something similar to Figure 30. The simulated messages are recognized
as matching our receive message, Decoded Ethernet Message. Notice in the Details View
area, center pane, that the signals/fields have all been decoded, including our custom Counter
field. This counter should steadily increase as a new message is played back from the
simulation every 500 milliseconds.

» Go Offline.
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Figure 30: Messages View with Decoded Messages.
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6 Creating and Transmitting Ethernet Messages

Now that we’ve seen how to create and work with Ethernet receive messages, let’s try

our hand at transmit messages. These can be used for a variety of purposes, such as
communicating with an Automotive Ethernet ECU, simulating the behavior of a network, or
diagnosing a network problem.

In this chapter we’ll create a sample Ethernet transmit message and then transmit it both
manually and automatically.

6.1 Creating an Ethernet Transmit Message

We saw in Chapter 5 that creating Ethernet receive messages is pretty much the same as
creating CAN receive messages, with the differences being mainly with respect to the structure
and contents of the messages themselves. The same is basically true of transmit messages as
well.

Once again we’ll begin by resetting Vehicle Spy to a clean slate, and then head over to the
Messages Editor.

» Reset Vehicle Spy: Select New from the File menu.
» Open Messages Editor: Select Messages Editor from the Spy Networks menu.
And again let’s switch to work with Ethernet.

» Select Ethernet Network: Click the drop-down box in the blue header and scroll down
until you find the “Ethernet” entry, then select it.

Since we start by default on the “receive side” of the Messages Editor, we will switch to the
“transmit side”.

» Switch to Transmit Messages: Click the button, which will change to have
blue highlighting.

And now we can create our message.

» Create Transmit Message: Click the 9 button to the right of the on Network drop-down
box.

Vehicle Spy will create a default Ethernet transmit message, which actually will look very
similar to the receive message we created earlier (see Figure 26). As before, we can rename
the message easily if we wish.

» Rename Transmit Message: Double-click the default message name “Tx Message
Ethernet 1” and change the name to “Transmit Test Message”.

As with the receive message, there are Ethernet Header and Ethernet Payload tabs in the
setup area. We can likewise change the message type by editing the EtherType field in the
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message summary if we wish, but for this exercise, we are going to stick with a raw Ethernet
message.

6.2 Defining a Signal in a Transmit Message

Defining signals in transmit messages is done in the same way that we saw for receive
messages in Section 5.3. Let’s create a 16-bit field this time. Since this is a raw Ethernet
message, the signal will be placed into the Ethernet Payload area.

» Select Ethernet Payload: Click the Ethernet Payload tab in the signals area.
» Add Signal: Click the down-arrow next to the */ button and select Add 16 Bit Signal.

Vehicle Spy creates a signal spanning bytes 15 and 16 of the message (recall that the Ethernet
header takes up 14 bytes). Let’'s change the default name.

» Rename Signal: Double-click the signal name “Signal 3” and change it to “Random
Data”.

Your Vehicle Spy window should now appear similar to that seen in Figure 31.

File Setup Spy Networks Measurement Embedded Tools GMLAN  Scripting and Automation  Run Tools  Help

| offline PIatform:[{None} v] (& Desktopl @ pata |~
o0 beszages Editor [+ =S J [ = ]
Cl+ -2 -[2e8|@
Description |Port | Destination [Port [Len |Raw Payload Bytes | Color
i i r o i N i
outd  Transmit Test Message Law 00:FC:70:00:00:01 00:FC:70:00:00:02

Setup for Transmit Test Message

Description Color Hotkey

Transmit Test Message I 5lack + |(MoHotkey) -

Signals in Mess5age | Ethernet Header | Ethernet Payload
+ |- j Equation [{Raw Value} |0, 1,112, 15 | [ AeEi. |

Signals in Message yte yte 17 |Byte |Byte |Byte |Byte

|Byte
Desaription 7|||||||||||||||||||||I|||||||I|||||||I||||||

Figure 31: Raw Ethernet Transmit Message.
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6.3 Using the Tx Panel to Set Transmit Message Signal Values

Since we are working with a transmit message, we will want to define the values we wish to
transmit when we go online. To do this, we will use the Tx Panel.

» Switch to Tx Panel: Select Tx Panel from the Spy Networks menu.
» Move Divider Bar: Slide the vertical divider bar left so the signals area is easier to see.

» Select Transmit Message: Click on Transmit Test Message in the message list on the
left side.

You should now see the four signals in the transmit message on the right. As we’ve already
seen, the Ethernet header fields are preloaded with default values; these can be changed here
if desired, but we will leave them alone. The fourth signal/field, Random Data, is the custom
one we defined. Its Value field is blank because we have not yet defined a value for it.

We could simply enter a numeric value into this field. But to make this exercise a bit more
interesting, let’'s make use of Vehicle Spy’s ability to fill in signals with calculated values.

» Edit Value Field for Random Data Signal: Double-click the cell under Value for the
Random Data signal.

» Select Random Data Equation: Click the down-arrow and choose Equation....

A calculated signal dialog box appears. It is already set to Random Data by default, so we only
need to specify the Min and Max values for the data. This is a 16-bit signal, so we’ll allow the
value to be anything in a 16-bit range.

» Set Min and Max Values: Enter “0” for the Min value and “65535” for the Max value.

Vehicle Spy will show you a preview of what the signal will look like with random data; an
example can be found in Figure 32. Let’s accept these changes.

» Accept Calculated Signal Parameters: Click [ o |,

Our transmit message is now ready, and will send a random value in its payload each time it is
transmitted.
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r Setup Calculated Signal: Random Data ——— g E@éy
i 0 &
Max 65535

40000

0.00 1.00 200 3.00 4.00

Signal Information Type: Analog Min: 0 Max: 65535 Units: Resolution (bits): 16

Figure 32: Setting Parameters for a Calculated Signal.

6.4 Transmitting a Message Manually

Let’s start by manually transmitting our message. We assume here that you are still set to
transmit on the same Internet connection you selected in Section 2.2. If for whatever reason
you no longer have this interface selected, go back to the Logon Screen now and be sure the
radio button is set to the right Ethernet adapter.

Appropriately enough, transmitting data is done within the Tx Panel. However, it is useful for
us to also have the Messages View visible as we do this, so we can see the messages as they
are going out. Vehicle Spy has a docking capability that makes this possible, so let’'s dock the
Tx Panel.

» Dock Tx Panel: Click the Tx Panel tab within Vehicle Spy and drag it until a blue box
appears. Continue dragging until the mouse is over the docking icon at the bottom of
the window and the blue box fills the lower half of the program. Then release the mouse.

» Reduce the Size of the Tx Panel: Drag the horizontal divider bar that currently
separates the Messages Editor from the docked Tx Panel down so the latter takes up
less space.

» Switch to Messages View: Select Messages from the Spy Networks menu. Messages
View now replaces the Messages Editor.

» Select the Ethernet Column Set.

» Reduce the Size of the Details View Pane: Drag the divider within Messages View to
make Details View smaller.

The Tx Panel includes a manual transmit button for each transmit message. We need only
click this to send our message.
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» Go Online with Transmit: Since in an earlier exercise we were simulating a file, you
will need to click the down-arrow and explicitly select Run with Transmit.

» Transmit Message: Click the | button for Transmit Test Message.

Our message should now have been transmitted. However, because of the amount of
messages constantly being sent back and forth in a typical PC, it may be hard to find. We can
use a filter to make this easier.

» Filter for Our Transmit Message: Enter “transmit” as a column filter under Description.

All of the other messages are hidden and we can now see our message. Your Vehicle Spy
screen should look something like Figure 33. Notice the Random Data signal, which in our
case has a value of 23298; yours will probably be different.
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Figure 33: Messages View and Tx Panel Display After Transmitting Ethernet Message.

6.5 Transmitting a Message Automatically

Sending a message manually is only practical if you need to send it a few times, or you are
trying to look for a specific response to a transmission. In many cases what we want is to send
the message periodically over time. Fortunately, VSpy makes this easy to do.

Notice in the Tx Panel the word “Periodic” next to the transmit button you pressed, under
the Auto Tx column. This means that the message is already set to automatically transmit
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periodically. However, we see “None” under the adjacent Rate column, so Vehicle Spy will not
actually send the message yet. We need to set an actual period rate, and then it will.

» Set Periodic Transmit Rate: Double-click the word “None” for our transmit message; a
drop-down box appears. Select “0.250” and hit Enter.

You will now see a new transmission of our message approximately every 250 milliseconds.
This also makes it easy to see that our selection to send random data is working correctly.

6.6 Graphing Signal Data

If we wish, we can use a signal graph to view our random data transmissions more easily.

» Open Signal Plot Window: Select Signal Plot from the Measurement menu.

» Select Signal to Plot: Click the [ sseas.. | button near the top of the Signal Plot
window.

» Select Random Data Signal: Click Tx Messages in the left menu, expand the Transmit
Test Message message if necessary, double-click Random Data and click [__oc__].

Vehicle Spy plots the random data in our signal. You should see a view similar to Figure 34.
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Figure 34: Signal Plot Showing Random Data from Transmitted Message.
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